
iVision-Mac 4.5 Release Notes
Also see the Camera Control, Motion Control and Deconvolution Release Notes for additional features.

Whatʼs New in iVision-Mac 4.5.2

The new features since 4.5.0 are marked in the text below with “4.5.1” & “4.5.2”.
Search for that text to jump to each addition.

4.5.2 Bug Fixes:
Fixed Delete File command to honor the “Ignore Missing” flag and show the “Keep” button in the 
alert.
Fixed Open and Delete File to use variable substitution for the Single File text item.
Fixed a bug that kept the Transfer Frames, Delete Frames, and Reverse Sequence commands dim 
when they should have been enabled.
Fixed a crash in Frames To Sequence that could occur if the source directory no longer exists.
Improved reading of CSV text files.
Fixed cosmetic issues in menus with ellipses.
Fixed a cosmetic issue with icons in the Device toolbar.
Improved the initial position of the histogram sliders in the Color Join normalization panel.
Fixed a bug in Image Arithmetic that incorrectly gave an “empty name” error when using the 
option to put the results into the first window.
Fixed a bug that could cause a crash when using the Flip command on drawings with arrow heads.
Fixed a possible crash when manually segmenting Color 48 images.
Fixed a long-standing bug in Segmentation with color images when the color to be segmented fell 
into certain ranges of red/orange.
Fixed a bug in Measurements that would append two superfluous columns to the results window 
when the “Perimeter: Line Method” measurement is selected.
Fixed a possible crash if you duplicated a measurement results window and then tried to add more 
measurements to it. (But to do this now you must duplicate the entire window, not a portion of it.)
Fixed a crash that could occur when trying to open a QuickTime movie file. (iVision does not 
import QuickTime movie files).

4.5.1 Bug Fixes:
Corrected degree symbol for angle measurement tool.
Corrected the cursor shown for Segment Paintbrush and Eraser tools. 
Fixed a bug that could prevent you from pasting text into a window name field, or into the file 
navigation dialogs.
Fixed a bug in transferring Row and Column names.
Fixed a bug reading Row and Column names from IPLab format files.
Improved resizing of columns in scripts when adding longer comments.
Fixed a bug that could keep you from copying or cutting script comments.
Fixed bug that kept Copy item in Edit menu disabled when is should have been enabled.
The Color Join command no longer leaves a segment layer on an image which did not have one 
prior to the use of the command.



Fixed a bug that did not clear the measurements window, usually seen when doing column-ordered 
measurements.
Fixed a bug that could let you drag an ROI past the edge of an image.
During a long Delay step in a script, a progress alert offers a “Cancel” button; a bug was fixed that 
kept that button from canceling the script.
Fixed a bug that kept the Segmentation dialog from returning to the last tab used.
Fixed a bug that broke the “Before/After” button in the AutoSegmentation dialog.
Fixed the tab order in the Duplicate Window dialog.
Fixed the placement of labels around drawing objects (the preference was being ignored).



Whatʼs New in iVision-Mac 4.5.0

Faster Processing on Intel-based Macs
iVision 4.5 is a “universal” application that runs on Intel Macs as well as PowerPC-based Macs.
(4.5.1 All PowerPC Macs which can run OS X 10.5 are now supported, not just G5 models.) 
Here are the times for a short script that reads 20 color files (800 x 600), converts them to 
grayscale, auto-segments them, measures them (mean & area, with area limit), modifies them 
(despeckle and median filter), and writes the new images to another folder:

G5 (2.30GHz) MacPro (2.26GHz)
iVision 4.0 33 seconds 38
iVision 4.5 26 15
speed up           > 1.25x            > 2.5x
Note that camera frame rates are not noticeably improved. The faster processing speeds will speed 
up scripts that do other processing during the capture loop, though.

PCIe support on Intel-based Macs
Cameras which use PCI-Express (PCIe) boards are now supported on Intel-based machines.

Scripts and non-device preferences are not convertible, yet.
Sorry about that.

New Menus
Some of the menu items have been re-arranged.
The items in the 3D menu have been moved to other menus (mostly Enhance). The optional 
Deconvolution  commands are now appended to the Enhance menu.
A new “Color” menu includes Color Join (previously in FCV) as well as other color-related 
commands from the old Enhance and Math menus.
The Analyze menu has been renamed “Measure”. The remaining FCV commands, if installed,  are 
appended to the Measure menu.
The Math menu now contains Image Ratios, Calibrate Intensities,  3D Stacked View and the 
Extract commands. The commands Swap 0 and 255 and Signed<->Unsigned have been combined 
into the new “Reformat Data” command.

Wider images can be displayed.
While  previous versions could create images up to 32767 pixels in width, they would not display 
grayscale images wider than 16380 pixels  or color images wider than 4095 pixels. In 4.5 all 
image types will display up to the maximum image width of 32767 pixels.

File/Image names: 255  Unicode characters
Unicode allows the use of "international" (non-Roman alphabet) characters.
There are some items where Unicode is still not fully supported including:



Row and Column Labels, Drawing Text, Device Position Names
To fully support these a new file format will have to be developed, because the older IPLab format 
does not store these items in Unicode.

New dialog window name field & resizable dialogs.
The window name field in dialogs is now a single edit field with a menu to the right of it. The 
menu includes "relative" window names that let you refer to windows based on their position, for 
use in scripts. The relative names are drawn in italics. To put in a specific name (e.g. "DAPI 
Image"), pick from the menu, or just type into the field and any italic name will be replaced.

Since window names can potentially be very long now, dialogs that contain window name fields 
can be resized horizontally to see the full name.



Commands                                                                                                                                                                                                                                                              
More commands allow you to specify the image to use.
Almost all commands that reference image windows now include a window name field, rather 
than only working with the front image. This should make scripting easier, since you don't have to 
worry as much about which image is at the front.

Open As replaced by enhanced Open command.
The "Open As" command let you tell iVision what format a file was (e.g. TIFF or PICT), so if the 
file had the wrong extension or file type associated with it you could still open the file. Since it 
was not used much and seemed to confuse people more than it helped them, the "Open As" has 
been removed. Its functionality has been included in the "Open" command.
To keep "Open" simple to use, the default file format is set to "Automatic". This will figure out the 
format of the file for you and open the image if it is in any format that iVision knows.

The "Automatic" format should be used in almost all cases.
The best reason to use a specific format is when using a script to open a large number of images 
that are all the same format but do not have an extension or other file type (e.g. from an old OS 9 
CD). In that case telling iVision the format will speed up the file reading.



Open Multiple Files at once, interactively.
The Open command allows you to select more than one file at a time interactively. 
Multiple  selections are not scriptable.

File Sets are just Indexed and Folder (no more List).
Dialogs with File Set menus in them also now have a “Show” button that will open the current File 
Set’s folder in the Finder.

Segmentation sets gone.
You can just place the segmentation command into the script without creating a segmentation set. 
This required that the number of colors saved for the Color Cube feature be limited to a maximum 
of 20.

Pseudocolor dialog expanded:
The "Predefined" menu is reduced to the "complex" color ramps, like Rainbow, Classify, and 
System, as well as the commonly used "Monochrome" and "Reverse Mono".
There are also two new options to create simple color ramps:

The menu to the right of the ramp choices lists "single color" color definitions (e.g. Red, Green, 
Blue, Cyan, etc.). You can add to this list with the new "Define Colors" command.



Edit CLUT replaced with Define Colors:
The Define Colors command lets you specify a single color and give it a name:

The dialog show what a darkfield and brightfield ramp made from this color will look like. If there 
is an image open when this dialog is open, you can apply either of the ramps to the image to see 
how they look. You can also step through the frames of the image to preview what the change will 
look like.

Color Join Command
The Color Join command from the FCV extension has been moved to the main program.
The colors in the Color Join command are shared with the Define Colors command.

Reformat Data Command
This command takes two older commands (“Swap 0 and 255” and “Signed <-> Unsigned”) and 
makes them options for a new command. A new option “Big Endian <-> Little Endian” has also 
been added. The effect of each option can be reversed by simply applying the change a second 
time. These options are useful when importing data that has missing or incorrect type information.



4.5.1 AutoSegment
The AutoSegment command now adds the segment to any existing segment rather than replacing 
it. This matches the behavior of the Segmentation command.

4.5.2 “Mosaic” renamed to “Join Images”, “3D Mosaic” renamed to “2D Mosaic”.
These names better describe what the commands do. The “Join Images” command only combines 
images at their edges, and the “2D Mosaic” command uses a 3D stack of images, but builds a 2D 
mosaic out of them.

4.5.2 Export To Movie
Separated the directory for the output file from the name of the file and added an “Ask” option.



Acquire Information Commands
4.5.1: Edit Image Notes
This command has been renamed from “Edit Image Info”. The two fields in here (Short 
Description and Notes) are now stored with the other acquisition fields (like exposure, etc.) This 
will preserve the values when the image is stored to TIFF files as well as IPLab format files. The 
Cmd-I keyboard short cut has now moved to the “Edit Acquire Info” command.

4.5.1: Capture Times
The Timing Window option in the Camera commands has been removed in favor of always storing 
the capture times with the images. 
For all captures the “Capture_Date” is the time the image was captured.
For timelapse or multi-wavelength captures the “Experiment_Date” represents the start of the 
entire capture.

4.5.1: Extract Acquire Times
This command, added to the Extract sub-menu, allows you to recover the capture times from a 
sequence of Z or T (timelapse) captures. The times can be relative to a variety of starting points.

As an example, imagine a Z stack captured at two wavelengths during a 4 step timelapse with 15 
seconds between captures. “Time Point” refers to the start of a timelapse capture. In our example 
there are 4 time points. The first (#0) is taken at the start of the experiment. There are then 3 more 
which begin 15, 30, and 45 seconds later. 
Start of Experiment: The frame times for a Z stack will be relative to the start of the experiment, 
so the final Z stack times will begin at least 45 seconds later than the times from the first stack.
Start of Time Point: The first time for the first frame of a Z stack at any time point will be 0. If 
the Z stack is “multi-pass” then the times for the second wavelength will start after the times for 
the first. For “single pass” the times for the two wavelengths will be interleaved.
Start of Sequence: The first time for the first frame of a Z stack at any time point will be 0 for 
any wavelength. Times that are relative to the start of the sequence should be nearly identical for 
any stack in the experiment, assuming the devices respond at the same speed throughout the 
experiment.
Start of Each Frame: The times for the sequence are reported relative to the previous frame, so 
any differences indicate a delay in receiving the frame from the camera. The first time is set to 
match the second to make it easier to graph the arrival times.



Files and Exporting Data                                                                                                                                                                                      
New Text File Format:
The text file format has changed from a proprietary one used in IPLab and iVision to the “Comma 
Separated Values” (CSV) format which can be imported by spreadsheet programs like Excel™ and 
Numbers™. The extension for this format is “.csv”. The text file format is usually only used for 
measurement results windows.
You can export a measurements window (4.5.1: or any other data window) and have it 
automatically open in a spreadsheet program by using the new “Export Measurements to File” 
command (File -> Export menu).

The program with which to open the file is set in the Preferences command (“File” tab). Note that 
if you change the measurements window (by, for example, adding more measurements to it) and 
then re-export it, Excel will close the old window and open a new one with the new 
measurements, while Numbers will keep the old one open and open a second, new, window.
If you have an older IPLab or iVision text file you can still open it in iVision  by using the Open 
command in the File menu, or by dragging the file to the iVision icon in the Dock or in the Finder. 
If you want iVision 4.5 to open the file by double-clicking on it in the Finder then you must 
change its extension to “.ivtxt”.

4.5.1 Use File Set
The Use File Set dialog now includes a prompt that will be displayed as the title of the file 
navigation dialog that is used when the script is run.



Changes to Variables                                                                                                                                                                                                           
For the most part variables still work the same as before. You still use a number with the "Var" 
button in a dialog to specify a variable.
But the Variables window has changed from an image window to a palette:

In this window the name of the variable is preceded by a lower case "v".
The Variable window only shows those variables that have been used at some point (and have not 
been removed). You can change the value of a variable in this window by clicking on the Value 
column and typing a new value. In addition, variables can contain text as well as numbers.

Updated Set Variables dialog.
The Set Variables dialog includes several ways to place text into variables:
• A new "Text" option to set any arbitrary text string.
• A "Window Name" option to place the name of an existing window into a variable.
• The "Acquire Info" menu now includes non-numeric fields such as Filter Names and dates,

which will be placed into the variable as a text string.
• 4.5.1 A “negate” (multiply by -1) option was added to the first two assignment options.



Updated Enter Variables dialog.
The Enter Variables dialog has been updated to add some formatting features, and to allow text to 
be entered into variables:

When the script is run, the result looks like this:

If the Help Tags are on, holding the mouse over each field will show which variable the value will 
go into (as a reminder when you are working on the script).
4.5.2 Added a “Window Choice” option that presents a popup of existing window names.



Using Variables in Text Fields
To use any variable (numeric or text) in a text field, you use a special formatting rule that lets you 
insert the value of the variable into the text.

Place the name of the variable inside braces: {v123}.
You can optionally use one of two formatting options for numbers: zero fill, or decimal places.
For zero fill you can specify a total length of 2 to 6 digits.
For decimal places you can specify 0 through 6 digits after the decimal place.
You specify the option by following the variable name with a comma and then a 'z' or a 'd', 
followed by the number.

Example:
if v42 = 12.547000000

{v42} => 12 (truncate)
{v42,z2} => 12 (truncate)
{v42,z3} => 012 (truncate)
{v42,z4} => 0012 (truncate)
{v42,z5} => 00012 (truncate)
{v42,z6} => 000012 (truncate)
{v42,d0} => 13 (round)
{v42,d1} => 12.5 (round)
{v42,d2} => 12.55 (round)
{v42,d3} => 12.547 (round)
{v42,d4} => 12.5470 (round)
{v42,d5} => 12.54700 (round)
{v42,d6} => 12.547000 (round)

You can put more than one variable substitution in a text field.
For example, if v10 = 4, and v12 = 32.4112:
"Experiment {v10,z3} temperature: {v12,d1} F" would produce:
"Experiment 004 temperature: 32.4 F".

Variable substitution is available in:
Window Names
Draw Text: text
Enter Variables: title, description, prompt(s) [for Enter Var and Title uses]
Script Query: title, message, button titles
Script Alert: title, message



Predefined Variables Reserved by iVision
Some variables have changed from iVision 4.0. Their old name is listed in the last column:

Variable Information Stored in This Variable By Command 4.0 Var
200 ROI left, by Extract: Image Sizes and Camera Extract Image Sizes,,

Camera Capture commands
201 ROI top “
202 ROI right “
203 ROI bottom “
204 ROI width “
205 ROI height “
206 Image width “
207 Image height “
208 Current Z (Current frame) Extract Image Sizes
209 Z depth (Total frames) “
210-211 undefined
212 Data Type “
213 XY Unit Factor “
214 Camera Binning, X direction Camera Capture commands
215 Camera Binning: Y direction “
216-218 undefined
219 Red Color Balance factor used by color cameras Camera Capture commands 220
220 Green Color Balance factor used by color cameras “ 221
221 Blue Color Balance factor used by color cameras “ 222
222 Segmentation Min (1) Segmentation (Simple/Histogram) new
223 Segmentation Max (1) “ new
224 Segmentation Min (2) “ new
225 Segmentation Max (2) “ new
226 Segmentation Min (3) “ new
227 Segmentation Max (3) “ new
228 Segmentation Min (4) “ new
229 Segmentation Max (4) “ new
230 Frame number of best focused frame  (Best Frame option). 3D Extended Focus
231 undefined
232 Threshold gray value calculated by AutoSegmentation. AutoSegment command
233..234 undefined
235 Current index used by the Iterate tab in StageScan. StageScan: Move/Iterate 232
236 Number of positions moved by the Iterate tab in StageScan. “ 233
237 undefined 234
238 Current row position within the array as set by Move/Iterate. “ 235
239 Current column position within the array “ 236
240 Current row position within the super-array “ 237
241 Current column position within the super-array “ 238
242 - 245 undefined
246 Z Start position for Multi-D Acquire. Multi-D Acquire
247 Z End position for Multi-D Acquire. Multi-D Acquire
248 Z Step size for Multi-D Acquire. Multi-D Acquire
249 - 254 undefined
255 Exposure time last used by Acquire commands. 

Exposure time for filter 1 used by Multi-D Acquire. 
Exposure time last used for Red channel in RGB Acquire.

Camera Capture commands 249 (MultiD
252 (RGB))

256 Exposure time for filter 2 used by Multi-D Acquire.
Exposure time last used for Green channel in RGB Acquire.

RGB & Multi-D Acquire 250 (MultiD)
253 (RGB)

257 Exposure time for filter 3 used by Multi-D Acquire. 
Exposure time last used for Blue channel in RGB Acquire.

RGB & Multi-D Acquire 251 (MultiD)
254 (RGB)

258 Exposure time for filter 4 used by Multi-D Acquire. Multi-D Acquire 252
259 Exposure time for filter 5 used by Multi-D Acquire. Multi-D Acquire 253
260 Exposure time for filter 6 used by Multi-D Acquire. Multi-D Acquire 254
261 Exposure time for filter 7 used by Multi-D Acquire. Multi-D Acquire 255



Scripts                                                                                                                                                                                                                                                                                   
The Script window has been updated. It is resizable horizontally as well vertically.

The END symbol now acts like a label,: you can jump to END without adding a label just above it.
4.5.1 Length of labels expanded to 31 characters.
You can start or finish editing  a Comment by pressing the Return or Enter key.
The Comment column can be toggled to show the parameters in the command:

Not all commands have parameter descriptions yet. More will be added in the future.



The search field at the top of the window will highlight any commands that contain the given text.
In this example the File Set named "Indexed Save" is used by two commands "Use File Set" and 
"Save As". The command name, the user comment, and the parameters are all searched for the 
given text. The search field remembers the last 10 searches:

The script commands palette includes two new commands: Enable and Disable.

These commands allow you to disable commands in a script, which causes them to be skipped 
over, as if they weren't in the script at all. Disabled commands are displayed in red:



Shared Scripts Folder
There is now a “Scripts” folder within the “iVision 4.5 Shared User Folder”. This acts as a 
convenient place to store scripts that are shared among all the users on one computer.

Sub-Folders
Scripts that call other scripts can now be stored together in a sub-folder within either the Scripts or 
Shared Scripts folder. This makes it easier to keep related scripts organized.

Scripts remember different size/placement than interactive dialogs.
If you are scripting a command where you want the dialog to be opened while the script is running 
(with the "+"), the size and position of the dialog used when the script is run will be saved 
independently from the size and position used when not running a script. So you can reliably place 
the dialog at a specific place on screen.

Scripts remember File Sets used by the script.
So if you move the script to another machine, it will automatically take the file set with it.

The Script Alert command has an improved run-time message option.

The first two options still put the message in a modal alert which can be closed after a given time 
period. The third option puts the message in the yellow “Cancel or Continue” floating window, so 
the user doesn’t have to dismiss the alert before doing whatever they are supposed to do:

4.5.1 Direct Assignment of Script to FKey
When a script is frontmost you can assign it directly to an unassigned FKey by pressing Option-
FKey (e.g. option-F5). A dialog will verify that you want to make the assignment. If the FKey is 
already assigned, the script for that FKey will be opened



The “If” and “Exit If” commands have changed.
These commands have changed to allow text comparisons. The first field is a variable, the second 
is a text string.

To compare against another variable, use variable substitution:

You should avoid comparing numbers as text because the text representation of numbers can 
include decimal places or rounding that you did not expect when the script was first written.

4.5.1 Start Loop Command
An optional feature has been added to the Start Loop command. It is common to keep a variable 
that increments within the loop as the loop runs. This can now be done as part of Start Loop/End 
Loop without adding extra Set Variable commands to your script.

This will initialize v42 to 1 when Start Loop is first run, and then increments v42 each time the 
matching End Loop step is reached. Note that End Loop will not allow you to use the same 
variable for the loop count as the one you are using in Start Loop.



Miscellaneous                                                                                                                                                                                                                                               
New File Extensions for iVision files:

iVision Scripts .ivsc
iVision Preferences .ivpr
iVision Extensions .ivex
iVision Device Modules .ivdm

4.5.2 Shared Preference Files
iVision now stores most user-defined data in preference files within the “iVision 4.5 Shared User 
Folder”. This allows them to be used from scripts on machines with multiple user accounts. The 
4.5.2 version will automatically move preference files from the user's folder to the shared folder at 
startup.

Separate FKey Preference File
The current FKey assignments are now written to a separate preference file “Command 
Data.FKeys” in the user’s iVision Preferences folder each time the program quits. This file is read 
after the main “Command Data” file and takes precedence over it. If the “Command Data.FKeys” 
file is placed in the Preferences folder within the Shared User Folder, then that file takes 
precedence over any in the user’s local Preferences folder. Since only the user’s copy is written to 
by iVision, a file in the Shared folder will not be affected by any changes the user makes to the 
FKey settings.
4.5.2 Number of FKeys expanded to 38
Added FKeys 16 through 19, shifted and unshifted.

About Box:
The About Box contains a popup menu which shows the name and version of all Extensions in 
use. This does not include device modules, which are listed in the Device Setup dialog. If you 
select “Reveal in Finder” a Finder window for the folder which contains iVision will open. This 
helps verify which copy of iVision is running (if there is more than one on the machine).

Similarly, the Device Setup dialog has an Open Folder button to show the current Device 
Modules folder.


	Predefined Variables Reserved by iVision

